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About this Guide:
This guide is intended to help anyone who would like to run a lesion symptom

mapping analysis but isn’t quite sure where (or how) to start. When I first started
running lesion symptom mapping (LSM) analyses in my PhD, I spent several months
meeting with different people who understood different bits of the processes and
compiled all the information I learned into the first draft of this guide. I’m hoping that
this guide can help other researchers design and run LSM analyses, without having
to spend months learning (like I did). 

Importantly, there are lots of different ways to run LSM analysis. This guide is
meant to be a starting point for people who don’t know where to start and will likely
be updated and expanded over time. If there is anything you as a reader would like
to  be  included/edited/expanded,  please  let  me know and  I  will  adjust  the  guide
accordingly. I’m hoping that if we all work together to keep what we know in one
place,  we  can  help  others  towards  designing  and  running  higher  quality,  more
informative LSM analyses. 

All  of  my  scripts  mention  in  this  guide  are  openly  available  on  my Open
Science  Framework  (Foster  &  Deardorff,  2017) profile  (https://osf.io/mv2qf/).  All
other programmes/software are available via the links provided in Appendix I. I plan
to incrementally improve and expand this guide over time. Feel free to get in contact
if you have any suggestions for the next version.
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Running any Lesion Symptom Mapping (LSM) analysis involves lots of little
processing steps. Most of the steps themselves are fairly simple (especially if you’re
comfortable with MATLAB), but it  can be complicated to understand the analysis
pipeline as a whole. The purpose of this section is to provide a brief overview of each
of  the  individual  steps  that  are  needed  to  complete  a  generic  univariate  LSM
analysis. This section should be helpful if you don’t really have a good idea of what
practical steps you (or one of your students) will need to take to run a LSM analysis.
I’ve provided practical details on what to think about and how to run each of these
individual processes in later sections.

First,  you need to  decide what question you’re going to ask your data.
There are no stupid questions, but there are a lot of questions which won’t yield
informative  LSM  results.  I  recommend  reading  “A  Hitchhiker’s  Guide  to  Lesion
Symptom Mapping” (de Haan & Karnath, 2018) to get a good idea of what questions
can and can’t  be appropriately addressed by different kinds of LSM analyses.  In
general,  LSM  tends  to  perform  well  when  you’re  looking  for  localized,  spatially
contiguous neural correlates in a large sample of patients with good lesion coverage.
LSM can produce false negatives when correlates are distributed (or bilateral) or
when  lesion  coverage  isn’t  good  enough  (Bates  et  al.,  2003;  Mah  et  al.,  2014;
Mirman et al.,  2018).  This  guide will  focus on univariate LSM which is  the most
common form of LSM, but there are many more advanced LSM (or Voxel Based
Morphometry)  variants  which  may  be  more  appropriate  for  specific  research
questions  (Geva et al.,  2012; Hearne et al.,  Under Review; Sperber et al.,  2019;
Zhang et al., 2014). 

Once you’ve settled on a question, the next step is to collect some data. All
LSM analyses need both behavioural data and a brain scan showing a lesion, ideally
collected at the same time point (de Haan & Karnath, 2018). In terms of behavioural
data, this can be any measure, but measures yielding continuous variables generally
do a  better  job  of  teasing  out  brain-behavior  relationships  (de  Haan &  Karnath,
2018). Any brain scan showing a lesion can be used. I generally use either CT or T2
MR, as these are often routinely collected and allow high-quality lesion segmentation
(Moore et al., n.d.). Importantly, behavioural data and scans should be collected at
the  same  timepoint,  as  cortical  reorganization  can  complicate  brain-behavior
relationships.  Ideally,  both  behavior  and  scans  should  be  collected  as  soon  as
possible following stroke (de Haan & Karnath, 2018; Karnath & Rennig, 2017), but
the importance of this practice depends on the exact questions being asked (more
on this later). 

Once you have your data, you generally need to convert the scan data from
its raw format (often DICOM) to something which can be read by the established
LSM  programs  (e.g.  NIFTI).  Once  this  is  done,  binarized  lesion  masks  can  be
created by lesion delineation (manually outlining the boundaries of lesions on each
slice of the native space scan). There’s several different manual, automated, and
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semi-automated ways to do this (e.g.  Gillebert et al., 2014; Ito et al., 2019), but in
this guide I will focus on manual delineation. Once lesion masks are created, native
space scans and lesions need to  be normalized into standard space to facilitate
group-level comparisons. No informative group-level LSM conclusions can be drawn
from looking at native space lesions alone, as factors such as head orientation, size,
and location make native space lesions impossible to informatively compare. Next,
it’s important to visually inspect all normalized scans and data, as sometimes the
programs performing these registrations make errors. Finally, you’ll generally need to
reslice  binarized lesion files so  that  each file  contains  an identical  number  of
voxels. 

Next, it’s time to analyze. There are several existing programs you can use to
run a LSM analysis.  I  generally use NiiStat (https://www.nitrc.org/projects/niistat/),
but you can use NPM (https://www.npmjs.com/package/download) or any number of
in house toolkits (Rorden et al., 2007). All these programs pretty much need you to
input each of your binarized lesion files and their associated behavioural data. You’ll
have to set a number of analysis parameters (e.g. corrections, minimum overlap, etc)
and each of these choices can dramatically affect your output. I’ll explain what you
should think about when making each of these choices later on. Finally, you need to
figure out how you want to report it.  I’ve included descriptions of a number of
different post-processing steps you can use to visualize, report, and interpret LSM
output data. 
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2 - Asking the Right Questions
It’s really important to understand that you can run a VLSM for pretty much

any research question, but that doesn’t mean you should ask any question. You can
run  through  each  of  the  analysis  steps  and  get  a  result  for  pretty  much  any
combination of behavioural and imaging data, but that doesn’t mean your result is
going be theoretically informative.  For this reason, it’s  really important  to have a
good  understanding  of  when  and  how LSM techniques  should  be  used.  In  this
section, I’m aiming to give readers a quick overview of the things they need to be
thinking  about  when  deciding  whether  or  not  LSM is  suitable  for  their  research
question. 

First, I’d recommend reading some basic papers about LSM methodologies to
get an idea of what questions LSM analyses are appropriate for answering. Below,
I’ve listed a series of questions you should think about and answer when deciding
whether LSM is appropriate for your data:

Is the behaviour of interest something that could be captured by LSM?
LSM is a widely used technique, but it is now without its limitations. Univariate

LSM (the method described in this guide) has several serious issues which can yield
uninformative (if not misleading results) if used on the wrong data. 

Mainly,  in  cases  where  underlying  behaviour  is  supported  by  multiple,
spatially distinct correlates (e.g. network-based or bilateral functions) LSM tends to
report the spatial average of the related correlates (Gajardo-Vidal et al., 2018). This
average may be in between the actual underlying correlates rather than at any of the
areas actually involved in the behaviour of interest. For this reason, univariate LSM
is better suited for investigating the anatomy of behaviours which are supported by
single, spatially contiguous neural correlates. This doesn’t mean you can’t use LSM
in  cases  where  your  behaviour  of  interest  might  involve  multiple  regions,  it  just
means you need to be cautious whilst interpreting the results of your analyses.

Similarly, LSM is not good at dealing with cases in which behavioural deficits
have bilateral correlates. This is due to the fact that having correlates which are far
apart  from  one  another  will  mean  that  there  will  likely  be  lots  of  patients  with
behavioural impairment who are included in the “spared” voxel-wise distribution for
many voxels. This reduces the effect size of voxel-wise comparisons, reducing the
probability that even significantly involved voxels will survive statistical testing. If you
think your deficit  might  involve bilateral  correlates,  it’s  best  to  run separate LSM
analyses for the right and left hemispheres.

Finally, LSM needs to have lots of patients with impairment in order to draw
informative  conclusions.  If  your  behaviour  of  interest  is  something  that  is  only
observed in a few individuals, it’s very unlikely LSM will yield informative results. For
example, I do a lot of work with word-centred neglect dyslexia ((Moore & Demeyere,
2017, 2018, 2020) but I’ve never tried to do any LSM on this data. This is because I
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only have lesion data from 2 patients with this condition, meaning that there’s no way
LSM would have enough power to detect the voxels related to this condition even if I
have a massive control group. 

Can scans/behavioural data be collected at the same timepoint?
This is a key issue. I recommend looking at this paper  (Karnath & Rennig,

2017) for more details on what exactly goes wrong when data from different time
points are combined. 

Stroke  lesions  evolve  very  quickly  over  time  and  many  post-stroke
behavioural  deficits  can  spontaneously  recover  very  quickly  (Karnath  &  Rennig,
2017; Stone et al., 1992). As cortical reorganisation occurs, and area which was not
previously  involved  with  a  lost  function  can  adapt  to  facilitate  this  function,
introducing spatial variation. This means that scans taken at a later stage post-stroke
(e.g. >1 month) shouldn’t really be used to try to elucidate the functional structure of
the brain (de Haan & Karnath, 2018). Chronic scans are great for studying the neural
correlates  of  chronic  impairment,  but  they  can’t  really  be  used  informatively
investigate the functional architecture of the brain (see (de Haan & Karnath, 2018)
for more details on this). 

Conversely,  it’s  also  not  really  informative  to  combine  acute  scans  with
behavioural  data taken at a later stage post-stroke. This again is because many
patients who may have shown the deficit of interest during the acute phase (and
shown associated lesions) may have recovered by the time of chronic assessment. 

Ideally, LSM imaging and behavioural data should be collected at the same
time point (e.g. within 1 week) as early as possible following stroke. If  this is not
feasible in your investigation,  it  may prove extremely difficult  to  draw informative
conclusions from your result. It may seem a bit extreme to say that data collected at
other time points shouldn’t be used in LSM, but both past research and my own
personal experience has convinced me that it is best practice to limit your sample to
the patients who have both acute imaging and behavioural data. 

Will you have sufficient statistical power?
As in any experiment, statistical power is extremely important in LSM. If your

investigation is not sufficiently powered, it’s impossible to say whether any of your
reported non-significant  results  represent real  null  results  (e.g.  true negatives)  or
false negatives (Cohen, 1992; Maxwell, 2004). In behavioural experiments power is
generally a function of the expected effect size and the number of patients included.
However, in LSM power needs to be considered at both the group-level and the
voxel-wise level.

In  order  to  complete  high-powered  voxel-wise  statistical  tests,  each  voxel
tested needs to be damaged in multiple patients. The number of lesions impacting
each voxel isn’t necessarily related to sample size, as you could include lesions from
hundreds of patients, but they may not necessarily have any overlap. This is why it is

6

MJ Moore



extremely important to use a minimum overlap inclusion threshold for all voxel-wise
comparisons. I generally aim to only test voxels damaged in at least 8 patients (see
my upcoming LSM simulation paper for details). If you test all voxels (e.g. with an
overlay > 0), there’s no way voxels impacted in such a low number of patients can
yield a significant result and these underpowered voxels therefore have a high risk of
being false negative results. 

Taking this into account, you should only run LSM analyses when it is feasible
to have sufficient lesion overlay throughout a good portion of the brain. There aren’t
really any set guidelines on what “good overlap” is. I generally just make a lesion
overlay of all the patients I want to include and make sure that the main areas I’m
interested in are damaged in at least 7-10 patients. This is particularly relevant when
you’ve  theorised  that  a  specific  ROI  might  be  related  to  your  deficit.  If  there  is
insufficient  overlap  in  that  ROI,  you  will  get  a  null  result  no  matter  what  the
underlying relationship between this ROI and your behaviour is. 

Mainly, if you’re thinking about running LSM but your maximum overlay is <8
patients, I’d recommend recruiting more patients before attempting an analysis. 

Is it feasible to include a representative sample of the target population?
It  is  generally  difficult  to  recruit  stroke  survivors  for  neuropsychological

research and many of the patients which end up in studies aren’t exactly the average
stroke survivor. In most data sets, it’s much more likely that younger patients with
smaller strokes meet standard inclusion criteria than patients with larger strokes. 

It is also quite common to exclude patients with specific deficits (e.g. aphasia).
This may seem to make sense for studies that aren’t aiming to investigate aphasia,
but this can ultimately result  in dramatically reducing the number and location of
voxels which can be tested. For example, if you end up excluding aphasiac patients,
you’re going to have to exclude more left hemisphere patients that right hemisphere
stroke patients. This often creates an imbalance in the distribution of lesions across 

3 - Collecting Data
In order to conduct LSM, you will  need lesion masks and behavioural data

from a set of patients. Behavioural data can be collected using pretty much any tool/
experiment, but there are a few things you should think about when deciding how
(and when) to collect this data. Similarly, lesion masks can be made from a variety of
imaging types, but choosing which imaging type to use can dramatically impact the
quality  and generalisability  of  your  results.  In  this  section,  I  will  provide  a  quick
overview of some things to keep in mind when collecting behavioural and imaging
data for use in LSM.

Timing (For both Imaging and Behaviour)
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As mentioned in the previous section, it’s critically important to make sure that
behavioural data and imaging data are collected at similar timepoints. Preferably,
both data sources should be collected as soon as possible following stroke in order
to facilitate inferences about the functional structure of the brain (de Haan & Karnath,
2018). If  scans and behavioural data are collected at the same time point further
after stroke (e.g. > 1 month), this data can still be used to investigate the correlates
of chronic dysfunction. However, it is not advisable to combine neuroimaging and
behavioural data collected at acute and chronic timepoints as this often confounds
effective  interpretation  of  results  (de  Haan  &  Karnath,  2018;  Karnath  &  Rennig,
2017). I would say that this is the single most important thing to keep in mind when
collecting data for LSM analyses.

Behavioural Data Distributions
LSM can be run on either  continuous or  binary data,  but  it’s  important  to

check the distributions of your data before analysis. Continuous data is generally
considered  best  for  LSM  as  these  analyses  generally  have  improved  statistical
power compared to binary comparisons  (Cohen, 1992).  However, if you’re using
continuous data,  even if  the group-level  scores are normally distributed,  it’s  very
probable that the distributions used in voxel-wise testing may not always meet the
assumptions of parametric testing (e.g. having a normal distribution). For this reason,
it’s often a good idea to use non-parametric testing or binarize your behavioural data
before LSM analysis. Again, there’s no one right way to do this. Chose whichever
method seems best for your data.

Neuroimaging Modality
It’s generally stated that MR modalities (e.g. FLAIR, T2, T1, DWI) are better

for lesion delineation. However, this is not necessarily a valid claim  (Moore et al.,
n.d.).

First,  MR does a good job of visualizing lesions but is expensive and not
everyone who has a stroke can actually have an MR  (Singer et  al.,  2004).  This
reduces  the  number  of  people  who  can  be  included  in  MR  LSM  studies  and
generally mean that their results may not be generalisable. In comparison, CT scans
have lower resolution but are more widely available and are routinely collected for
every patient with a suspected stroke (Rabinstein & Resnick, 2009). 

I’m  working  on  publishing  a  very  large  simulation  study  which  effectively
shows that there’s no major difference in LSM studies which employ CT- or MR-
derived lesion masks (Moore et al., n.d.). Overall, this study shows that MR- and CT-
derived lesion masks exhibit  good agreement in location,  overlap, and size.  MR-
based LSM was able to test more voxels than CT-based analyses, but CT-based
analysis results were closer to the underlying target voxel. The results yielded by
paired CT and MR LSM analyses demonstrated good agreement in terms of dice
coefficient when systematic differences in cluster size and lesion overlay are taken
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into  account. Overall,  this  project  shows  that  there’s  not  actually  that  big  of  a
difference between using lesion masks that were drawn on CT and MR in lesion
mapping analyses.

This finding has some important implications. First,  LSM analyses can and
should use CT data (a point also made by de Haan & Karnath (2018) and Moore &
Demeyere (Under Review)). CT data is cheaper and more widely available, meaning
that using this data will likely dramatically increase the number of patients able to be
included (versus MR only analyses). Lesion overlay is one of the most important
factors underlying analysis accuracy (see my upcoming paper for details/evidence),
so  it’s  critically  important  to  include  as  many  patients  as  possible.  CT  is  also
collected  for  everyone  with  a  suspected  stroke,  while  a  substantial  non-random
portion of the stroke population can’t  actually  complete MR scans  (Singer et  al.,
2004).  For  this  reason,  using  CT  may  also  help  your  LSM  sample  be  more
representative of your population of interest.

However, CT does have some disadvantages. It’s generally much easier to
delineate lesions on MR than CT (see the lesion delineation section for more info),
meaning that you’ll need a higher degree of expertise to use CT data versus MR
(Bryan et al., 1991; Rabinstein & Resnick, 2009). Overall, the imaging you employ
will depend on the exact data you have available to you. In summary, you can use
either CT or MR in lesion mapping analysis, as long as the imaging was collected at
a similar time point to the behavioural data. 
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4 - Converting Raw Scan Data

Overview: In order for scan files to be read by common analysis programmes such
as SPM, NiiStat,  and MRIcron,  they generally  need to  be in nifty  (.nii  or  .nii.gz)
format. When downloaded from a scanner, most scans are in DICOM (.dcm) format
instead. This section will  walk you through how to convert scans from dicom/nifti
using a MATLAB script I wrote. If you’re comfortable with coding, you can write your
own script  or modify mine if  you want it  to be done differently.  If  not,  follow the
instructions below. 

What you’ll  need: MATLAB, DICOM files,  Statistical  Parametric  Mapping (SPM)
software, my DICOM conversion code (DicomtoNifti_V2.m - https://osf.io/mv2qf/)
What does this do?: Converts all DICOMS to Nifti files and moves them to a new
folder
Why this is important: Scans generally need to be in nifti format before they can be
viewed by most programs used for manual delineation. 

Basic Procedure:
1. Open the “DicomtoNifti_V2.m” in matlab 
2. Change the file path in line 6 to the folder containing all your patient DICOMS
3. Change the file path in line 7 to the folder where you want the converted nifti

files to go
4. Run the code and wait for the code to finish (usually 1-4 mins per scan)
5. Check the output folder to make sure it now contains the patient files

Notes: 
Make sure the file containing your DICOM files either has each patient in a

separate folder or all the DICOM in the same folder. These scripts do not deal well
with directories within directories within directories.

If you want your output to be formatted differently (e.g. patient ID is wrong).
You can adjust the arguments for the function spm_dicom_convert in line  32. Your
options should all be explained thoroughly in the script documentation. 

This step is pretty straight forward. If you run into any issues make sure the
file paths (and directory structures) needed by the code match your data structures.
If there is a different problem it will likely be with one of the SPM functions called by
the script. There are plenty of resources for debugging these functions online, but
NEVER make changes to the SPM script files (unless you really know what you’re
doing). Debug these files to find what’s causing the error but always change your
inputs  to  the  function,  never  the  actual  function.  The  SPM  functions  are  really
versatile and a small change can cause lots of problems. 
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DICOM files generally contain information for multiple nifti scans. It’s common
for each scan session to contain between 3-10 separate scans. Most of these scans
aren’t relevant for lesion delineation. The next section will detail how to choose the
right scans for analysis.

5 - Choosing Scans to Delineate
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Overview:  Once you’ve converted DICOM files to nifty, it’s possible you’ll end up
with multiple scans for each patient. Most of this data will not be relevant. I’ve written
a script (NAME) which automatically identifies most scans which won’t be usable
which makes checking through them a lot faster. Again, the pipeline I’ve described
below is only one of many ways of doing this. It is, however, the method I’ve found to
be most efficient.  

What you’ll need: MRIcron, raw nifti files, my nifti cleaning script (NiftiCleaner_V1_
Moore.mat - https://osf.io/mv2qf/))
What does this do?: Finds all useful scan data and choose the right file to delineate
Why this is important:  As you will see, each patient scan folder contains lots of
different scans, but not all of them are relevant to us. We only want to keep data
which we can use for research.

Basic Procedure:
1. Download and open the nifty cleaning script (NiftiCleaner_V1_Moore.mat) and

set filepath (in line 4) to the directory containing your data
2. Run the script and wait for it to finish (usually < 5 mins)
3. Manually check through all  the scans sorted into the “good scans” file in a

nifty viewer such as MRIcron or FSLeyes (more details later)
4. Chose the best-resolution scan (more on this in notes)
5. Move or rename this usable scan to mark it for use in later analysis

How to View Scans 
To open a .nii file in MRIcron (Rorden et al., 2007) , simply double click on it

(assuming MRIcron is the default viewer). If MRIcron does not automatically open,
right click on the file and set MRIcron as the default opening program. If the image is
a CT scan you will need to manually set the contrasts to view the image in any detail.
To do this,  enter 0 and 70 in the contrast boxes (located just to the right of the
“greyscale” menu). You can then click the up and down arrows on the “Z” box menu
to scroll up and down through the axial view of the scan. To see the axial view in
more detail, select “View>Display>Axial Only” in the MRIcron top bar menu.

To open a .nii file in FSLeyes, open FSLeyes and click the little “+” button in
the bottom, left-had panel. You can then chose your file and it will open in the viewer.
You can set the contrasts to 0 and 70 in the boxes in the top toolbar labelled “min”
and “max”. FSLeyes is more modern and user-friendly than MRIcron, but can’t be
used for lesion delineation. 

It’s fine to use either of these programs to visually inspect scans. I tend to
prefer  MRIcron  for  this,  as  opening  multiple  native-space  scans  in  FSLeyes
simultaneously  can  cause  some  strange  visualisation  errors  which  will  look  like
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banded distortions in the image. These are caused by native space scans being in
different sizes an orientations. If this happens, just close all open scans in FSLeyes
and restart. 

How to choose the correct scan:
In my own scan database, I keep the best quality scan of each modality on

each testing date and discard all other scans. I’d recommend looking for scans which
have the full brain in the Axial Plane and have good resolution. I generally delete all
scans which do not contain the full  brain or have worse resolution than the other
existing  scans,  as  these  scans  can  always  be  remade  if  you  keep  the  original
DICOM files. If there are two scans from the same date of similar resolution, choose
the one you can see the damage more clearly on.

My NifitCleaner script is written to automate some of this selection process. It
works by checking the sizes of each nifti file. Scans which are too small are generally
only a few slices (e.g. locator scans) and are not useful for analysis. Scans which are
too big (eg > 400 z slices) are generally very small slice thicknesses (<1mm) and (in
my data) tend to be very poor resolution and absolutely awful to delineate manually.
If you’re comfortable with MATLAB, you can change the parameters that this script
uses to sort out data to match the data you’re working with. Importantly, this script
doesn’t delete any scans, but simply moves most of the scans to a folder called “Bad
Scans”. If  none of the scans flagged as being good are acutally usable, you can
always use one of the scans flagged as bad. This script just aims to save the user
some time.

Once  the  NiftiCleaner  has  been  used,  I  recommend  viewing  each  scan
flagged as being “good” and choosing the scan which looks best for delineation. I
made a flowchart for people in my lab, which helps them decide which scans are
worth keeping (see below). In general, choose one scan from each date which does
the best job of visualising any damage. There can be several very similar scans
collected in each session, and it’s ok just to chose which ever one looks best to you. 

At the end of this process, you should have one usable scan for each patient.
It’s  important  to  note that  not  all  scans (especially  acute CT scans)  will  show a
lesion, even if the patient has a confirmed diagnosis of stroke. Unfortunately, scans
with no lesion must be excluded from analysis. 
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6 - Lesion Delineation

Overview: Manual  lesion delineation is definitely the single hardest  step in  LSM
analysis. It takes a lot of time to learn to “read” neuroimaging scans (especially acute
CT scans) and it’s not a skill that can be easily taught. I’ve included links to a number
of resources which can help people learn to do this, but I think the best way to learn
is just by practicing. I taught myself to do this by practicing delineating lesions and
checking the resultant mask against existing delineations. The best way to learn is to
get trained by someone who knows what they’re doing, but if you don’t have access
to someone who’s already trained, this guide should help you get started. 

What you’ll need: MRIcron, final CT scans
What does this do?: Create binarized lesion masks for each patient.
Why this is important: You can’t run anatomy statistics or lesion comparisons if you
don’t have the extent of damage quantified.

Basic Procedure:
1. Open each scan in MRIcron
2. Visually scan each image and find any lesions
3. Outline and fill each lesion using the pen and fill tools
4. Smooth your lesion mask

Notes:
Lesion delineation isn’t something that can be taught. I have attempted to train many
students how to do this, and the only people who actually end up gaining the skill are
those who are willing to put a lot of time in teaching themselves. In this guide, I’ll
walk you through how to quantify lesions, but if you want to learn to see lesions you’ll
need to do a lot of work on your own. The difficulty of this task will be determined by
what kind of data you have. It’s pretty simple to see lesions on most MR modalities
and on chronic CT imaging. However, finding and quantifying lesions on acute CT
scans can be a real challenge. 

You can train yourself to find lesions by looking at the scans which have already
delineated, practice finding lesions, practice delineating the lesions, then comparing
your lesion masks to mine and adjusting your strategy accordingly. I can’t make my
lesion training set openly available due to potential patient anonymity issues, but feel
free to get in contact with me if you need some data to learn on. 

A  good  knowledge  of  neuroanatomy  (key  structures,  vascular  territories)  will
definitely make it easier to see lesions, but isn’t strictly necessary. Most importantly,
you need to know what acute/chronic ischemic and haemorrhagic strokes look like.
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I’d also recommend becoming familiar with other age-related changes such as white
matter hypo/hyper intensities, atrophy, and calcification. It’s important to build up an
idea  of  what  a  “normal”  scan  looks  like  in  your  population  before  you  can  find
abnormalities. For example, I work with stroke survivors so it’s quite common to have
huge amounts of age-related atrophy and white matter changes. These changes can
look like lesions to the untrained eye.

Here are some resources for learning about stroke anatomy and clinical imaging:

1) A tool neuroradiologists use to document lesions. This isn’t delineation but it
will help you learn about different kinds of lesions and how to read CT scans:
https://www.ed.ac.uk/clinical-sciences/edinburgh-imaging/education-teaching/
short-courses/training-tools/acute-cerebral-ct-evaluation-stroke-study-access

2) This  textbook  has  lots  of  useful  pictures  and  contains  a  lot  of  general
information about stroke neuroimaging. It’s in the library:
https://www.amazon.com/Practical-Neuroimaging-Stroke-Case-Based-
Approach/dp/0750675373

3) Resources for learning anatomy:
https://headneckbrainspine.com
https://apps.apple.com/gb/app/3d-brain/id331399332

Detailed Procedure:
First  off,  open your  scan in  MRIcron and set  the  contrasts.  I  recommend

adjusting the contrast lower boundary between 0 and 20 while viewing the scan to
help make lesion boundaries more clear. 

Find your lesion. Look for key signs of stroke (e.g. obvious hypo-intensities or
bleeding,  hyperdense Middle  Cerebral  Artery  (MCA),  insular  ribbon sign,  loss  of
contrast,  swelling,  etc.).  Make  sure  to  consider  information  from  multiple  slices
before making your decision. Always check the full brain in detail. Many scans show
multiple strokes. 

Once  you’ve  found  your  lesion.  Select  the  autoclose  pen  tool  and  draw
around your lesion boundaries on a single slice. I generally start on the slice where I
can see the edges most clearly then work my way up/down the scan. Once you’ve
delineated a lesion on one slice, use the fill tool to fill the area. This is only slightly
more complicated than using the Paint programme. Repeat this procedure for every
slice lesions are visible on. Use the wizard hat tool (I really don’t know what this is
actually  called)  to  check  to  make  sure  your  lesion  masks  match  the  scan
underneath. 
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Adjust your lesion masks if necessary. You can hold shift and click to erase a
filled area or press control z to undo (but this is only allowed once). This programme
is not very user friendly.

Once you’re happy with your masks, chose the Draw>Smooth VOI option in
the  toolbar  to  open  the  smoothing  window.  Set  the  smoothing  value  to  5mm,
threshold to 0.5,  and leave the other options as they are.  You can adjust  these
settings if you have a good reason to, but otherwise this is what I use in all my LSM
studies. This is really important to do properly as all data needs to be formatted the
same.  Once  you  are  sure  your  options  are  correct,  press  OK.  You  can’t  undo
smoothing or easily smooth a saved VOI so be sure to do this right the first try.

Once the VOI is smoothed, check through the scan to make sure the lesion
isn’t  too  distorted.  Once  you’re  happy  with  your  lesion  mask,  save  it  as
PatientID_Date_Lesion and close.

Note that the lesion will  likely save in .voi format. You’ll  need to convert it
to .nii before it can be read in by SPM, but this is easy to do.

7 - Creating Reorientation Matrices
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Overview: Native space lesion masks aren’t that helpful for analysis. To understand
affected anatomy and make group-level comparisons we need to normalise each
lesion  into  standard  space.  Creating  reorientation  matrices  is  a  way  to  make
normalising  more  accurate.  SPM  generally  struggles  to  normalise  scans/lesions
without a normalisation matrix (and often fails to), so this is a tedious but necessary
pre-processing step.

What you’ll need: MATLAB, SPM
What does this do?: Manually checks to make sure scan origin coordinates are set
in the appropriate location
Why this is important:  Scans which are manually reoriented will have to undergo
fewer  transformations  during  normalisation.  This  means  that  the  output  of  the
normalisation program will be more accurate. Many scans can’t be normalised with
out a manually created reorientation matrix

Basic Procedure:
1. In the spm12 GUI select, “Display”
2. Select the raw CT scan file for each patient
3. Set contrasts
4. Locate and click on the anterior commissure
5. Select “Set Origin” then “reorient”
6. Save the reorientation matrix for future reference

Detailed Procedure:
Open MATLAB and enter spm fmri into the command line. If spm does not

open correctly, make sure all spm folders and subfolders are on your path. This is
almost always the problem. One spm is open, click on the “Display” button within the
green GUI window and navigate to the directory containing your patient’s lesion files.
It  is  a bit  challenging to navigate through directories in spm. You can make this
process as easy as possible my making sure that the file containing all your patient
scans is the working directory in MATLAB when you initiate spm. This will prevent
unnecessary file switching. To move up one directory select the “..” option. Before
opening a patient file, ensure that the file contains both a scan file and a lesion file.
Spm can only read .nii files so if your lesion was saved as a .voi it won’t show up
here. If this is the case, you will have to convert each .voi file to a .nii file before
creating reorientation matrices.

Converting .niis to .vois:
To  convert  a  .nii  file  to  a  .voi  file,  open  MRICRON  then  select

Draw>Convert>VOI to NII and open the .voi file you’d like to convert. This will create
an equivalent .nii file in the patient directory. 
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Viewing Scans in SPM:
Once you have .nii scans and lesions for each patient, the next step is to view

these scans in spm. Do this by selecting the “Display” option in the green spm GUI
and selecting the scan file you wish to view. Do not add in the lesion file. 

If  the scan is a  CT scan,  contrasts can be adjusted by selecting “Manual
Window” in a drop down window located in the lower right box in the spm viewer.
This  window is set  to  “Automatic  Window” by default.  Once “Manual  Window” is
selected a dialog box will appear within the grey spm GUI which will allow you to set
the contrasts. Enter 0 70 into this box to view the scans. You can navigate through
the scans by clicking and dragging the blue crosshairs to the location you wish to
view.

Sometimes the spm viewer GUI throws an error when you attempt to view a
new scan. This can generally be corrected by closing the GUI and reopening it. If this
does not work, try to close all of spm then reopen it to view the scan.

Finding the Anterior Commissure:
The anterior commissure is a small white matter tract which connects the two

hemispheres across the midline. This tract serves as the origin point [0, 0, 0] in the
program which warps patient scans to standard space. The anterior commissure is
located at the anterior end of the fornix in the sagittal view, between the inferior end
of the anterior lateral ventricles in the axial view, and in the “moustache” of white
matter fibres between the lateral ventricles in the coronal view. This video provides a
useful  description  of  how  to  find  this  tract  https://www.youtube.com/watch?

v=AwNJAUKLhqY.
This tract can be a bit tricky to locate on poor quality CT scans. While it is

important to be as exact as possible, it is perfectly fine if the coordinates you set are
not  perfectly  aligned  with  this  structure.  The  closer  the  origin  is  to  the  anterior
commissure,  the  better  the  normalisation  will  be,  but  most  scans  can  still  be
normalised even if the anterior commissure cannot be precisely identified.

Reorienting Scans:
Set the crosshairs to the anterior commissure in all  three views. Press the

“Set Origin” button and then the “Reorient” button. Both buttons are located in the
lower left dialog box in the spm display GUI. A box will pop up asking if you would
like to save the reorientation matrix for future use. Select “Yes” and save the file in
the directory containing both your patient scan and lesion file. This will allow for the
lesion file to be reoriented using the same matrix. Repeat this process for all patient
files. Make sure that the reorientation matrix is saved in the same file as the patient
native space scan and binarized lesion file. 

8 - Normalising Scans and Lesion Masks
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Overview: Normalising  to  standard  space  is  essential  for  LSM.  This  section
describes how to use a script I wrote to automate the normalising process which can
be done manually  in  SPM. This isn’t  the only  way to  normalise data,  but  it  has
performed well for me in the past. Importantly, this process uses age-specific CT and
MR templates made for use with stroke lesion studies. If your study isn’t in stroke
survivors, you can adjust the script to use a different template image.

What  you’ll  need: MATLAB,  spm12,  my  Scan  Normaliser  script
(https://osf.io/mv2qf/)
What does this do?: Reorients native space scans to standard space
Why this is important:  You can’t run group-level or anatomical analyses on scan
data until it is normalised. 

Basic Procedure:
1. Open MATLAB and SPM
2. Run the script “ScanNormaliser.m”
3. Watch and wait (generally 1-2 minutes per scan)

Notes:
I’ve written a script that sets all the parameters and automates normalisation.

If  you’re  curious  about  how  this  works,  have  a  look  at  the  script  and  the  spm
functions it calls. It’s a lot of math but it’s pretty simple to use. You’ll have to set the
directory paths in lines 22 – 25 to match where you’ve put your data and toolboxes.

This  script  iteratively  calls  the  spm  base  functions  clinical_ctnorm  or
clinical_mrnorm.  These  functions  takes  the  inputs  V  (filenames  of  scans  to
normalise), les (filenames of lesions to normalise), vox (voxel size), bb (bounding
box), DeleteIntermediateImages (0/1 logical), and UseStrippedTemplate (0/1 logical).
I’ve set these inputs to the standard values I use, but feel free to change them if
needed. The spm functions documentation contains more details on what each input
should be, You can run this function manually in the SPM GUI, but it’s much faster to
loop through data automatically using a scrips (like the one I’ve written). 

In order to run this script,  you’ll  have to make sure the scans you want to
normalise are in the correct directory structure. If you haven’t reoriented these scans,
you’ll likely get an error. If your lesions are in .voi format, you’ll get an error. It will
also  be  important  for  you  to  either  format  each  scan  name  like  I  do
(ID_DATE_MODALITY.nii) or adjust the code to recognise the modality and filename
format of your own scans. The code I’ve written is quite specific to my way of naming
things, so I’d recommend naming your scans like I do. It’s easier than making the
lots of little changes which would be needed to get the script to work with other
filename structures.
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9 - Checking Normalisations
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Overview:  Unfortunately, the output from spm’s normalising functions isn’t always
usable.  This  generally  is  due  to  abnormalities  in  brain  structure  (e.g.  enlarged
ventricles,  atrophy,  midline shifts,  very large lesions) that  mean the native space
scan isn’t  properly warped into standard space. These mistakes are very easy to
catch  by  visal  inspection,  as  the  normalised  scan  will  either  not  be  aligned  to
standard space or the normalised lesion mask will fall outside the boundaries of the
standard brain. Below, I’ve detailed the procedure I use to double check all my data
is properly normalised before moving on to later stages of analysis. 

What you’ll need: Normalised Scans, scct.nii (or another standard brain template),
FSLeyes
What does this do?: check to make sure your scans have normalised well
Why this is important: Not all scans normalise well and you can only use properly
normalised scans in analysis

Basic Procedure:
1. Open scct.nii in FSLeyes
2. Overlay the wScan.nii and bswLesion.nii file
3. Check to make sure they match well
4. Upload Good scans to the scan database

Detailed Procedure:
I generally use FSLeyes to view and compare scans. You can use another

NiftiViewer, but FSLeyes is best because you can save a lot of time by scripting the
process in  UNIX.  If  you’re  not  familiar  with  FSLeyes,  there’s  lots  of  good video
walkthroughs  showing  you  how  to  use  the  program  (e.g.
https://fsl.fmrib.ox.ac.uk/fslcourse/lectures/practicals/intro1/index.html).

To check each normalisation, you’ll need to open a standard space template
(e.g. scct.nii) in FSLeyes and overlay each normalised scan with it’s accompanying
normalised lesion. I recommend setting the contrasts for each of the scan files so
you can see tissue differences clearly and changing the colour of the lesion overlay
so that it stands out. Next, you can use the eye tool and crosshairs tool to check that
the scans overlay well. I recommend placing the crosshair at key points within the
standard  space  brain  (e.g.  skull/brain  boundry,  ventricle  edges)  and  turning  the
normalised data overlay on/off to ensure that these points line up reasonably well
between  the  standard  brain  and  the  normalised  scan.  I  generally  work  my way
through these steps:

1. Check  to  make  sure  the  normalised  scan  relatively  matches  up  with  the
template. I  do this by placing the crosshairs on the normalised scan, then
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turning the scan off to see whether the crosshair point matches the template.
Check multiple places around the skull and lateral ventricles for alignment.

2. Repeat this process with the lesion. If  the lesion extends into the template
skull, doesn’t match well with the anatomy impacted on the native space scan,
or is too big/small it cannot be used. Only exclude lesions if you are confident
they are bad. The most common problem will be that large lesions are in or
outside the skull of the template.

3. If a lesion is good, move the normalised data folder to a “keep” location. If the
scan is bad, move it to a “do not use” location. In most cases, scans which
don’t normalise well can’t be corrected so there will be some inevitable data
loss here.

You  may  notice  that  these  steps  will  take  a  lot  of  time  to  run  through
(especially if you have lots of scans to normalise). I speed up this process by using a
UNIX  script  to  automatically  open  FSLeyes,  add  the  relevant  files,  and  set  the
contrasts/colours automatically. This is a simple process, but it saves a surprising
amount of time. Here’s an example of a script I use:

for i in *; do echo ${i};fsleyes /Applications/spm12/toolbox/Clinical/scct.nii -dr
2000 4500 ${i}/wp*CT*nii -dr 0 70 ${i}/bws*nii -a 40 -dr 0 70 -cm Blue; done

For  people  who  aren’t  familiar  with  UNIX,  UNIX  is  code  run  from  your
computer’s terminal. It’s really useful for automating processes that would normally
take a lot of clicking, opening files, moving things around etc. FSLeyes (and FSL)
plays well with UNIX, so you can automate most pipelines that require doing the
same  thing  more  than  once.  To  open  your  terminal,  find  the  terminal  in  your
computer’s applications and open. You can’t use the mouse in the terminal (only
arrow keys and keyboard commands). To start this script, you must first navigate to
the directory containing your normalised scan files. To do this type cd DIRECTORY
PATH into your terminal. If it works, nothing should appear to happen. Next, type ls.
If  you’re  in  the  right  place,  all  the  directories  containing  your  normalised  scans
should be listed. To run my script you’ll need to change “Applications/spm12/toolbox/
Clinical/scct.nii” To whatever directory contains your standard space template file. 

Here’s a step-by-step translation of my code:

for i in *; - This is UNIX syntax for looping through all the files in the current directory

echo ${i}; - Tells the terminal to print the name of the ith directory in the file

fsleyes /Applications/spm12/toolbox/Clinical/scct.nii – Opens the standard space template

file in FSLeyes
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-dr 2000 4500 – sets the standard template contrasts to 2000 and 4500. This will be different for different

templates

${i}/wp*CT*nii – open the normalised scan file from the ith directory in FSLeyes. You may need to change

the index (wp*CT*nii) to something that will catch all your scan files if you’ve formatted your names differently
than I do

-dr 0 70 – set the normalised scan contrasts to 0 and 70

${i}/bws*nii – opens the binarized lesion file from the ith directory

-a 40 – sets the lesion file opacity to 40%

-dr 0 70 – sets the lesion file contrasts to 0 and 70

 -cm Blue; - sets the lesion file colour map to Blue (pretty)

 Done – ends the loop (this process will be repeated for every file you have, to move to the next directory, just

close FSLeyes)

What to do with bad normalisations: 
You’ll notice that not all data normalises well. Sometimes the lesions are just

a bit outside of the skull, and other times the scans are completely misaligned. Bad
normalisations are generally completely unusable, so there’s no point keeping them.
You  can  try  to  fix  normalisations  by  re-making  re-orientation  matrices,  adjusting
normalisation  parameters,  and  re-running  normalisation.  This  rarely  makes  a
difference, but it can sometimes save a scan or two. 

10 - Reslicing Lesions

24

MJ Moore



Overview:  Once you have successfully normalised your data, there are still a few
steps you need to  go  through before  analysing.  First,  it’s  generally  important  to
ensure that all your lesion files are exactly the same dimensions. This can be done
by reslicing lesions in SPM. This is a fairy quick and easy process which will prevent
errors later on in the analysis pipeline. By now I’m assuming you know the basics of
SPM, MRIcron, and MATLAB. These instructions will be a bit higher-level, but you
should be able to follow them if you’re familiar with these programmes 

What you’ll need: MATLAB, spm12, lesions to be resliced
What does this do?: Reslices your lesions so they all have the exact same number
of slices.
Why this is important: You’ll need to do this before you create any lesion overlays
or calculate anatomy statistics

Instructions:
1. Open the spm GUI
2. Select the Corregister (reslice) option from the dropdown menu in the top left

corner
3. Set “template defining space” to the ROI (.nii file) you want all yours to match.

I  generally  use  any  area  from  the  atlas  ROI  files  in  my  lesion_toolbox
(available on OSF) atlas directory (e.g “HOC_Angular_Gyrus_L.nii”). You can
use any file you want if you just want to create an overlap, but if you want to
run anatomy statistics you’ll have to choose a ROI from one of the template
atlas ROIs. 

4. Set “images to reslice” too all the normalised lesions you want to reslice.
5. Press run
6. Check your output. All resliced files should now begin with the letter “r”. Only

use resliced files for VLSM/anatomy/overlay analyses 

11 - Creating Lesion Overlays
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Overview: It is surprisingly important to create lesion overlays at an early stage of
the analysis pipeline. I generally use lesion overlays to evaluate whether my data is
even good enough to think about running LSM on. It’s also important to include a
lesion overlay figure in any LSM paper, as your readers can use it  to see which
voxels you’ve actually included in your analysis and get an idea of your voxel-wise
statistical power. There are several different ways to do this.  

What you’ll need: MRIcron (or SPM12)
What does this do?: Turns your lesions into overlap visualisations
Why  this  is  important:  Overlap  visualisations  help  evaluate  the  quality  of  the
analysis you’re able to run and are important to include in LSM papers.

Instructions:
1. Open a standard space template file in MRIcron and set the contrasts. 
2. Select Draw>Statistics>Overlay
3. Select all the .nii files you want to overlay and press ok
4. Name and save your file
5. Choose colour scheme. I recommend NIH.
6. Set  contrasts  for  the  overlap  statistic  (minimum  above  0.1  and  set  your

maximum so that no covered areas are left blank)
7. Use the Window>Multislice option to make visualisations. 

1. use the View>Slices option to choose which slices to display
2. use the View>Overslice options to change the overlap

Notes: 

You can  also  do  this  in  SPM12 in  the  Batch>SPM>Util>ImageCalc  GUI.  Lesion
overlaps are automatically generated by NiiStat during VLSM. However, I  find it’s
generally best to look at an overlay before spending time running a LSM to decide if
it’s even worth analysing the data. 

12 - Running VLSM 
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Overview: This step is probably the main reason that you’re here. Running LSM
itself  is  surprisingly  simple.  If  this  section  doesn’t  provide  you  with  enough
information there’s lots available on the NiiStat webpage. 

What you’ll need: MATLAB, NiiStat, Excel datafile, lesion directory of normalised
scans
What does this do?: It runs VLSM
Why this is important: it is important if you’d like to run VLSM

VLSM is fairly complicated. It’s important to understand exactly what each option is
doing  and  why  you’ve  selected it.  VLSM can be  very  problematic  because it  is
comparatively easy to run, but rather difficult to fully understand. This means that lots
of people make mistakes when designing their studies and organising their data that
can cause very serious issues in their results, but don’t know enough to notice these
problems. A good rule of thumb is to never do/change anything unless you know
exactly why you’re doing it and why you’re doing it that way. You can always look to
previous VLSM studies to see what other people have done and why. 

Before you run VLSM you should:

1. Read papers: 
1. https://www.sciencedirect.com/science/article/pii/S0028393217303962

(absolutely  necessary  to  read  and  understand  this  one.  Use  it  to
determine whether your data is good for VLSM)

2. VLSM  versus  VBM:
https://www.sciencedirect.com/science/article/pii/S2213158212000046

2. Ask yourself: Does my data suit a VLSM analysis?
1. Do you have enough patients? (I’d say there’s no point running a

VLSM analysis  on  less  than  30  people.  It’s  also  important  to  think
about what proportion of your sample is actually impaired. If you have
100 people but only 2 of them are impaired, you’re not going to get an
interesting results)

2. Is  there  sufficient  overlap/coverage  in  your  patient’s  lesion
overlays? (Always look at your overlays before deciding if a VLSM is
appropriate. You may have enough patients but if your lesions are too
spread  out,  you  won’t  be  able  to  conduct  statistical  tests  with  any
power

3. Is there sufficient variance in your behavioural data? (You should
not  analyse  non-normal  behavioural  data  using  traditional  LSM.
Instead, use non-parametric analyses or binarise your data)
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4. Is the construct you’re trying to map likely multifocal? (VLSM has
difficulty finding bilateral/multifocal rois, meaning that a null result may
not be informative and a positive result may be incomplete)

3. If  you  pass  all  these  checks  (or  know enough  to  disagree  with  this
general guidance), you need to clean up your data.
1. Set up data directory

1. copy all relevant patient binarized normalised lesion files into a
single directory

2. You can use my script VLSMScanMatcher.m to help match scan
file names to IDs.

3. Make sure the number of patients in your patient list is the same
as the number of scans in your directory

2. Convert Nii files to Mat (optional)
1. I  generally  do  this  as  it  allows  NiiStat  to  regress  out  lesion

volume (to control for stroke severity) in LSM analysis
2. Use  the  NiiStat  function  nii_nii2mat(niinames,

modalityIndex, disknames, roi) to convert a list of nii

files to mat.  Documentation for this function is available here:
https://github.com/neurolabusc/NiiStat/blob/master/nii_nii2mat.m
. I’ve also uploaded a short script I use for this on my OSF page
in the Misc Scripts folder. 

3. Run the script and wait for the conversions to complete.

3. Make an excel file
1. Excel  files  must  contain  the  patient  lesion  file  name  (exact

match) and corresponding behavioural variable.  Double check
your  file  extensions match the  format  of  lesions you want  to
input (e.g. .nii or .mat)

2. NiiStat reads low scores as impairment, so keep this in mind
3. Your excel sheet (not the workbook, the sheet) must be named

NiiStat. If not the programme will fail.
4. Unless  you  really  know  what  you’re  doing,  only  use  one

behavioural variable
5. Reslice  all  lesions  before  using.  Make  sure  the  lesion  name

listed in your excel file corresponds to the resliced lesion, not the
native space one. 

4. Download and Run NiiStat
1. Link: https://www.nitrc.org/projects/niistat/
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2. Download, open MATLAB, add the genpath to your path, and open the
GUI by typing NiiStatGUI

3. If a GUI pops up, you’ve done it right

5. Set up VLSM Analysis
1. Set data directory: enter/select the filepath of the directory containing

your binarized, resliced lesion masks
2. Set output directory:  enter/select the filepath of wherever you’d like

your results to be saved
3. Select excel file:  enter/select the filepath of your excel file. This file

must be inside your data directory and must contain a sheet named
NiiStat

4. Name for  Results  Folder:  change this  to  whatever  you want  your
results folder to be named

5. Minimum overlap: set the minimum overlap of voxels to consider. Do
your research to choose a specific value and know why you’ve chosen
it. Smaller values lead to more comparisons but less power. 

6. Corrections:  Again  do  your  research  and  know  which  one  you’re
going  to  choose  and  why. FDR  is  commonly  used  and  less
conservative.  Bonferroni  is  highly  conservative  (generally  too
conservative),  but  I  usually  use it  because I  generally  include a  lot
more patients than normal (e.g. >400). Permutation based corrections
are a powerful tool but take up a ton of computing power. Permutation
corrections can take hours or days to complete so be careful. To use
FDR you need to click another option then click back to the FDR option
otherwise  Bonferroni  is  used  as  default  (fault  in  the  GUI).  I’d
recommend  reading  what  other  studies  have  done  and  deciding
accordingly.

7. Corrected P: use 0.05 unless you have a good reason not to
8. ATLAS  tab:  choose  your  atlas.  I  generally  use  Voxel-wise

comparisons (upper right corner – will turn grey when selected). Unless
you have a good reason not to, you should probably use this one too.
You can use the anatomy toolbox codes to get atlas results later.  I
don’t recommend ROI-based analyses as they effectively assume that
each  voxel  within  an  ROI  is  involved  in  the  same  function  (which
generally isn’t entirely correct). 

9. MODALITY  tab:  choose  LESION  unless  you’re  not  doing  lesion
analysis (which would be weird, given that you’re reading this guide).

10. SPECIAL tab: If you want to choose an of these options (and have a
reason for doing so) go ahead. I generally regress for lesion volume, as
it  controls  for  stroke  severity  related  effects.  In  my  experience,
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reviewers will ask for you to do this. Notably, your files must be in .mat
format for this to work.  

11. SPECIAL + :  To be honest,  I don’t know why this tab exists. Best to
ignore it.

6. Run VLSM
1. Once you’ve set all your presents, press the GO button and keep an

eye on your command window. It will report how many voxels are being
considered, the correction thresholds being used, z-thresholds, z-range
and number of significant voxels

2. This can take quite a long time. 500 scans with 1 binary variable and
FDR corrections takes about 15 minutes but the same analysis with
permutation corrections (>2000) could take days. 

7. Visualise/Interpret Results
1. Open the thresholded z  output  file  over  a  template  standard  space

scan in MRIcron and set contrasts. Use the z-threshold and maximum
z value reported in the .txt results file to set the stat maximum/minimum
values. Check your z-stat range to determine whether your threshold
needs to be positive or negative

2. Do your results “look” right? Are they in the correct hemisphere? Do
they match what you expected based on visual analysis of your lesion
overlay?

13 - Using the Anatomy Toolkit
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Overview: The anatomy toolkit is a tool I use to link voxels in LSM output or lesion
files to anatomical names defined in standard atlases. These scripts were originally
written by Celine Gillebert  and Dante Mantini,  but I  was responsible for adapting
these original scripts into their current versions available on my OSF page. If you do
end up using them in any published analysis, be sure to give all of us a mention in
your acknowledgements. 

What you’ll need: MATLAB, SPM12, lesion_toolbox scripts, atlas ROIs, binarized
lesion maps (resliced)
What does this do?: Calculates anatomy statistics for binarized lesion masks
Why this is important:  This is how you can actually find out which regions are
damaged for VLSM results and for individual patient lesion masks

Basic Procedure:
1. download the lesion_toolbox folder from my OSF page (LINK)
2. Open the Atlas_Output_V2 script
3. Modify  the  file  paths  in  lines  26-67  to  match  your  data  directories,  atlas

locations, and script folders
4. Enter the file paths for the atlases you want to use in lines 64-67 (see atlases

folder for details)
5. Run the code
6. Get anatomy details from the Excel files which the code outputs. There should

be individual files for each patient as well as summary fraction/extension* files

*Fraction = proportion of ROI damaged. Extension = proportion of lesion in ROI

Notes: Keep an eye on the command window. This code will let you know what it’s
doing and when it runs into issues. 

This code will  print out an excel sheet for each atlas used for each lesion mask
included as well as summary excel sheets for each atlas used. I generally use this
script to make tables summarising the anatomy impacted by each significant voxel
cluster (see Moore et al., 2021; Moore & Demeyere, Under Review). 

14 - Additional Tools to Help Interpret VLSM Results
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Overview: While  the  lesion_toolbox  scripts  do  yield  most  of  the  results  worth
reporting in any LSM manuscript, there’s a few extra tools I often use to help report
and  summarise  my  results.  I’ve  included  a  brief  description  of  these  tools  and
several different approaches for secondary LSM results analysis below.

What you’ll need: MATLAB, VLSM results, scripts available on OSF
What does this do?: Helps you make sense of VLSM results
Why this is important: Raw VLSM results are a bit difficult to interpret. Here are a
couple ways you can make sense of them

Option One: Run Basic Anatomy Statistics
To determine which anatomical areas are significantly associated with your

behavioural variable, run the thresholded z statistic results file (usually prefixed with
“thresh”.  Through  the  lesion_toolbox  scripts  (described  in  part  three).  You  can
compare  your  lesion  to  both  grey  and  white  matter  atlases,  and  report  these
statistics in your manuscript. 

Option Two: Anatomical Regressions
VLSM anatomical analysis yields which areas are significantly associated with

a behavioural  impairment,  but doesn’t  report  how much variance is explained by
each implicated ROI. You can determine this by conducting a regression with each
implicated area’s fraction and lesion volume as covariates. This will  tell  you how
much variance is really explained by each ROI and will  yield a nice equation for
predicting impairment. 

Be conscious that this is inherently “double dipping”. However, you can apply
regression models to new patients, or new behavioural variables to test if they’re
generalisable and specific to the deficit you’re looking at.

Option Three: Peak Analysis
It’s generally not helpful to say something like “impairment X was associated

with damage to the left opercular cortex”. The opercular cortex (as an example) is a
large region with multiple different subdivisions. Different atlases define these areas
in different ways and if you really want your readers to know exactly what you found,
you need to report the MNI coordinates of your areas.

You can use my script MNIcoordreader to find the global  z-value maximum
and print out it’s MNI cords. You can use the View>MNI coordinates function on a
loaded template (File>Load Template) in MRIcron to check which areas these peaks
fall into. See this paper for a really excellent example really detailed, useful peak info
(https://www.frontiersin.org/articles/10.3389/fnhum.2012.00230) or any of my VLSM
analyses to see simpler examples.
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Option Four: Backwards Inferences
Not all data is well suited to VLSM and there are lots of other analyses you

can do on lesion  data.  One cool  option  is  evaluating  other  people’s  findings by
seeing what  proportion  of  patients  with  damage to  a  specific  ROI  actually  have
impairment. For example, a lot of past research has suggested that the right angular
gyrus  underlies  neglect.  I  could  evaluate  this  theory  by  taking  all  patients  with
damage to the R angular gyrus, seeing how many of them actually have neglect, or
conducting a binary regression to see how R angular gyrus damage predicts neglect
impairment.

This approach is not perfect. ROIs are not homogenous and effects driven by
subregions of ROIs won’t be picked up well in this analysis. However, it’s something
cool to play around with.

Option Five: Finding the “centre of mass” of lesion clusters
Sometimes it’s helpful to identify the “centre of mass” of thresholded voxel

clusters. I’ve written a couple scripts to do this (SCRIPT NAMES).  Feel free to play
around with these if this is something you think might help your analysis. Be careful
when using these scripts with multifocal lesion masks as this will yield weird (and not
very informative) results. 

14 -  How to write up LSM results
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Overview:  It’s  extremely  important  to  communicate  LSM  findings  clearly  and
concisely. If you’re not sure how to do this, I’d recommend finding a couple past LSM
papers that you think are well written, and mimic the methods/results structure in
your own manuscript. I’ve included some checklists and examples from my recent
LSM paper (Moore et al., 2021) to help you get an idea of how to report what you’ve
done.

Key information to report in Participants Section:
1) All  the  basic  patient  info  you  would  include  in  any  study  (demographics,

consent, inclusion/exclusion, etc)
2) When neuroimaging and behavioural  data  was collected  relative  to  stroke

event
3) Basic  stroke descriptives  (Lesion  hemisphere,  stroke type,  stroke territory,

lesion size, etc.) 

Sample Demographics Chart (Moore et al., 2021):

Table 1. A breakdown of the clinical characteristics of patients within each VLSM analysis
group. Test Date reports the interval between stroke and behavioural testing in days. Scan
Date reports the interval between stroke and neuroimaging data collection in days. Lesion
sizes  are  reported  in  cm3.  Standard  deviations  are  provided  in  parentheses.  Visual  field
deficits  as  classified  by  the  OCS  are  provided.  L = Left,  R = Right,  B  =  Bilateral,
Ego = Egocentric, Allo = Allocentric.
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Key information to report in Lesion Data section is:
1) Neuroimaging modality used (e.g. CT/MR)
2) How delineation was performed (including smoothing)
3) Reorientation procedure

Sample Lesion Data Section (from Moore et al., 2021):

The extent and location of patient lesions was quantified using clinical CT (n = 376) and MR
(61 T2, 3 T1, 6 FLAIR) whole-brain scans obtained as a component of routine post-stroke
clinical  imaging.  Patient  lesions  were  manually  delineated  on  native  space  scans  using
MRIcron (McCausland Centre for Brain Imaging, Columbia, SC, USA) by investigators who
were blind to behavioural results (Varjacic et al., 2018). All lesion masks were smoothed at
5 mm full width at half maximum in the z-direction and binarized using a 0.5 threshold using
built-in MRIcron smoothing functions. Smoothing is a standard lesion pre-processing step
which helps prevent minor variations in delineation user input from impacting analysis (de
Haan and Karnath, 2018). These scans and lesion masks were then reoriented to the anterior
commissure and warped into 1 × 1 × 1 mm stereotaxic space using the Statistical Parametric
Mapping 12 and Clinical Toolbox (Rorden et al., 2012) functions. All normalised scans and
lesions were visually inspected for quality before conducting lesion mapping analyses. This
lesion preparation process represents a standard analysis pathway which has been used in a
number of previous VLSM investigations (e.g. Varjačić et al., 2018).

Key information to include in Statistical Analysis Section:
1) How many LSM analyses were conducted?
2) Was the analysis voxel-wise or ROI-based?
3) What  statistical  tests  were  used?  (depends  on  whether  data  in  binary  or

continuous)
4) Minimum overlap voxel inclusion threshold
5) How many voxels were tested
6) How statistical corrections were performed
7) Was lesion volume controlled for and if not, why?
8) Any post-processing (e.g. how was anatomy determined?)

Sample Statistical Analysis Section (from Moore et al., 2021):

Four  VLSM  analyses  were  conducted  to  determine  the  neural  correlates  egocentric  and
allocentric neglect within patients exhibiting left and right visuospatial neglect. These VLSM
analyses were conducted on a theory-blind voxel-wise basis using the MATLAB package
NiiStat (https://github.com/neurolabusc/NiiStat). Given that continuous impairment severity
metrics  (centre  of  cancellation  or  allocentric  proportional  scores)  were  employed,  this
software employed one-tailed  pooled-variance  t-tests  to  evaluate  voxel  significance.  Only
voxels which were lesioned in a minimum of 10 patients were considered (n = 589,216, Fig.
2).  These  analyses  employed  a  highly  conservative  Bonferroni  correction  (corrected
35

MJ Moore

https://github.com/neurolabusc/NiiStat
https://www.sciencedirect.com/science/article/pii/S0028393221002773#fig2
https://www.sciencedirect.com/science/article/pii/S0028393221002773#fig2
https://www.sciencedirect.com/topics/neuroscience/brain-imaging
https://www.sciencedirect.com/science/article/pii/S0028393221002773#bib66
https://www.sciencedirect.com/topics/neuroscience/statistical-parametric-mapping
https://www.sciencedirect.com/topics/neuroscience/statistical-parametric-mapping
https://www.sciencedirect.com/topics/neuroscience/anterior-commissure
https://www.sciencedirect.com/topics/neuroscience/anterior-commissure
https://www.sciencedirect.com/science/article/pii/S0028393221002773#bib14
https://www.sciencedirect.com/science/article/pii/S0028393221002773#bib14
https://www.sciencedirect.com/science/article/pii/S0028393221002773#bib65


alpha = 8.49 × 10−8,  z-cut = 5.23)  and  controlled  for  lesion  volume.  This  conservative
analysis  approach was employed to  harness  this  study's  extremely  large  sample size  and
testing  space  to  prioritize  specificity  over  sensitivity  (Sperber  and  Karnath,  2017).
Specifically,  this  analysis aims to locate  “core”,  highly significant  lesion sites rather than
peripheral areas which are less strongly associated with neglect impairment. Lesion anatomy
was evaluated versus the Harvard-Oxford Cortical (Desikan et al., 2006) and John's Hopkins
University White Matter (Mori et al., 2005; Wakana et al., 2007) atlases.

Finally,  the voxel maps produced by each VLSM analysis  were compared to analyse the
degree of overlap between voxels associated with different neglect impairments. Specifically,
voxel  maps  for  similarly-lateralised  egocentric  and allocentric  neglect  were  compared  to
confirm whether these conditions can be dissociated at an anatomical level. Next, the voxel
maps associated with left hemisphere neglect impairments were inverted to overlay with their
right-hemisphere  homologues  in  order  to  quantify  the  degree  of  similarity  between  the
correlates of right and left hemisphere neglect. All analysis output files and behavioural data
are  openly  available  on  the  Open  Science  Framework  (Foster  and  Deardorff,  2017)
(https://osf.io/vf9ew/). All additional data is available upon request.

Key information to include in Results Section:

1) Basic  descriptive  (lesion  size,  maximum  overlay,  behavioural  score
ranges/deviations)

2) Lesion overlay (to show readers where you could and couldn’t test)
3) How many significant voxels (in each analysis)
4) Peak voxel-wise z-score value and location (e.g. MNI cords)
5) Descriptive anatomy of significant voxel cluster (summary in text, details in

chart)

Sample Results Section (from Moore et al., 2021):

Fig. 2 presents the lesion overlay for all 446 participants within the voxels included in VLSM
analysis. The highest lesion overlap (n = 69) was present within the MCA territory. Patients
with neglect (defined as any impairment on the ego and/or allocentric measures, n = 197)
were  found  to  have  significantly  larger  lesions  than  participants  without  neglect  (mean
volume  51.57 cm3 versus  24.12  respectively,  t  (445) = 14.793,  p < 0.001).  A  one-way
ANOVA analysis revealed a significant relationship between neglect type and lesion volume
(F (5,191) = 4.026, p = 0.002). (…)
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VLSM analysis of left egocentric neglect yielded 11,526 significant voxels with the peak z-
score (z = 7.392) centred within the left parietal operculum (MNI 39–34 19). This significant
voxel  cluster  impacted  a  number  of  left  temporo-pareital  cortical  areas  including  the
supramarginal  gyrus,  and  planum  temporale,  lateral  occipital  cortex (superior  division).
Voxels within underlying white  mater  tracts  including the  internal  capsule (posterior  and
retrolenticular parts), tapetum, and posterior corona radiata were also significantly associated
with left egocentric neglect impairment. Full anatomical statistics of significant voxels are
reported in Table 2.

Table 2. Detailed anatomical descriptions of the significant voxel clusters identified in each
individual VLSM analysis. Starred ROIs contain the peak z-values for each VLSM test. Full
anatomical descriptions for each voxel cluster are available on the Open Science Framework.
Fraction represents the proportion of each ROI covered by each significant z-statistic map.
All anatomical areas are defined based on the Harvard-Oxford Cortical Atlas (HAROX) and
the Johns Hopkins University White  Matter Atlas (JHU). Hem = hemisphere (Left/Right).
Nsig = number of significant voxels within each ROI.

37

MJ Moore

https://www.sciencedirect.com/science/article/pii/S0028393221002773#tbl2
https://www.sciencedirect.com/topics/neuroscience/corona-radiata
https://www.sciencedirect.com/topics/neuroscience/internal-capsule
https://www.sciencedirect.com/topics/psychology/occipital-cortex
https://www.sciencedirect.com/topics/psychology/planum-temporale
https://www.sciencedirect.com/topics/neuroscience/supramarginal-gyrus
https://www.sciencedirect.com/topics/neuroscience/parietal-operculum


Again, there’s lots of different ways to run analysis and report data. These examples
are included as a beginner’s guide to what an informative (and publishable) LSM
manuscript might look like. 

15 – Conclusion

I hope you’ve found this guide to be helpful. If you have any questions or have an
idea for what else might be helpful to include, feel free to get in contact. I hope to
keep expanding and improving this guide over time as I learn more about LSM. I’m
beginning to move towards network-based and multivariate LSM approaches in my
own work, and will add instructions for these analyses to this guide sometime in the
future. Don’t hesitate to get in touch with me if you have any questions. I think the
scientific community benefits from more open sharing of knowledge, so I’m happy to
hear any suggestions for improvement and ideas for contributions to this guide. 
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Appendix 1: Software Download Links

Relevant Software:
1. MATLAB (https://uk.mathworks.com/downloads/)
2. MRIcron (https://www.nitrc.org/projects/mricron)
3. FSL / FSLeyes (https://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FSLeyes)
4. SPM12 (https://www.fil.ion.ucl.ac.uk/spm/software/download/)
5. Clinical Toolbox for SPM (https://www.nitrc.org/projects/clinicaltbx/)
6. NiiStat (https://www.nitrc.org/projects/niistat/)

Download and Setup Notes:
Make sure to carefully follow all the instructions on the relevant software download
website. If any program is downloaded in the wrong location (or not included in the
filepath), errors will  occur. NiiStat is not great at letting you know what has gone
wrong  when  something  has  gone  wrong,  including  when  it  can’t  access  spm
functions. 
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Appendix 2: Common NiiStat MATLAB Errors
Overview:  If  you’re not comfortable using MATLAB, working with the scripts and
programmes described in this guide is probably going to be hard. To help out, I’ve
listed some common MATLAB errors (in red) and described how to fix them below.
This list  isn’t  comprehensive, but  it  should help out with some of the most likely
things to cause issues. If you’re struggling with anything else, google is your friend.
99% of learning to code is just googling questions until you remember the answers. If
things are going wrong, it’s not because you’re dumb it’s because coding is hard and
it takes a while to get used to the new way of thinking. 

When I’m debugging code, I  ask myself several questions to make things easier.
First, I try to find the line that’s causing the problem. This is generally listed in the
error output. Once you find the line which is making the error, simple errors are easy
to spot.  I  check whether it’s  a typo (e.g. wrong formula,  extra comma, etc.)  and
whether all variables look like what I’m expecting them to (e.g. right data type, size,
and content). If a variable is wrong, I try to figure out what line of code made this
error and repeat the process described above. There’s lots of different ways to do
this. This is just what works for me. 

This list is by no means comprehensive. I’m planning to expand it by new adding
errors and fixes whenever I encounter them in analyses.

General Errors:

Unrecognized function or variable NIISTAT/SPM FUNCTION NAME …

This is generally caused by one or more of the needed packages or directories not
being added to the path. Double check the file paths you’ve entered and re-add all
niistat and/or spm files (and sub-files) to the path and try again. 

'spm' is not found in the current folder or on the MATLAB path, but exists
in:
    /Applications/spm12

Change the MATLAB current folder or add its folder to the MATLAB path.

This one is pretty self-explanatory. Add SPM (folders and subfolders) to your path
either by using the function addpath() or using MATLAB GUI. 

ANY ERROR WHILST RUNNING SPM NORMALISATION FUNCTIONS

Not all scans can be normalised, but most normalising errors can be corrected. Make
sure your scan/lesion files match up in a nifti  viewer (e.g.  MRIcron) and that the
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reorientation matrix file is saved in the correct directory (e.g.  same folder as the
scan/lesion files). Check to make sure you’re using the right SPM clinical toolbox
template for your imaging modality. This should automatically be set by my scripts,
but it won’t work if you don’t have the modality in your file name.

If this doesn’t fix it. Try normalising a different scan/lesion pair. If the error you had
before isn’t happening with new data, the original scan/lesion pair proabably can’t be
normalised. A real normalisation error should only impact a few scans (e.g. about 10
of my 500 couldn’t be normalised). If it’s happening for every scan, there’s something
wrong with your code, data, or analysis pipeline. SPM errors are generally pretty
good at telling you what’s gone wrong so read them carefully. 

NiiStat Errors: 

Unable  to  perform  assignment  because  the  left  and  right  sides  have  a
different number of elements. 

Error in nii_stat_core (line 105)
    sumImg(good_idx(:)) = sum (les, 1);

Error in NiiStat>processExcelSub (line 1075)
        nii_stat_core(les,  beh,  beh_names,hdr,  pThresh,  numPermute,
logicalMask,statname, les_names, hdrTFCE, nuisance);

Error in NiiStat (line 261)
        processExcelSub(designMat,  roiIndex,  modalityIndex,numPermute,
pThresh, minOverlap, regressBehav, maskName,
        GrayMatterConnectivityOnly,  deSkew,  customROI,  doTFCE,
reportROIvalues, xlsname, kROIs, doSVM, doVoxReduce, hemiKey,
        interhemi, statname,GUI, nuisanceMat); %%GY

Error in NiiStatGUI/GOButtonPushed (line 448)
            NiiStat;
 
Error  using
matlab.ui.control.internal.controller.ComponentController/executeUserCallba
ck (line 410)
Error while evaluating Button PrivateButtonPushedFcn.

If you get this error whilst running NiiStat, there’s usually an issue with how you’ve
resliced your lesion files. The lesion files you are trying to analyse are usually a) not
all the same sizes or b) not binarized. To correct this, double check that all the files
are the same dimensions and that  the .nii  files only  contain  0s and 1s.  If  more
numbers are present, you’ll need to threshold the images so that they are binary. 
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Appendix  3:  Sample  Procedure  for  Downloading
DICOM files from an NHS Database

Note from Margaret: This is the guide I wrote up to help my lab members download
raw scan data from the John Radcliffe Hospital in Oxford UK. I’m not sure if this will
be helpful to anyone outside of Oxford, but I wrote it so I’m including it here. It is in its
rough draft (very informal) form. 

What you’ll need: Access to the Research Office in the John Radcliffe, PACS login
information, Lots and lots of patience.
What does this do?: Pulls patient data from the hospital database, anonymises,
and downloads so that we can use it for research
Why this is important: We need brain data to learn about brain things.
Basic Procedure:
1. Login to both the PACS and research computer
2. Find patients in PACS
3. Send relevant data to ClearCanvas workstation
4. Delete dose files and anonymise
5. Upload scans to a removable hard drive

Note: This  section  is  adapted  and  reformatted  from  Jacob  Levenstein’s
(jacob.levenstein@ndm.ox.ac.uk) guide which was adapted from an original guide
written by Kevin Bowden (no idea who this is, but credit where credit is due).

Logging Into Computers
This process involves using two computers, both are located in the Stroke

office on the 7th floor. The computer on the left is currently a university computer
(donated by CNC) and the computer to the right is an OUH machine. First, make
sure the (currently red) ethernet cable from the research computer is plugged into
the wall  to the right.  These two ethernet ports are on the hospital  IP. If  needed,
please unplug the grey cable that might be on the right slot and is connected to a
phone. Do not unplug the OUH computer’s ethernet cable, as both the Research and
OUH computer need to be plugged in the OUH IP. 

To log into the hospital  computer (Right)  use your OUH login credentials or ask
Rachel Teal to log you in. To login to the university computer (Left) use the user
profile “Research” and password “research”.
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Locating Clinical Imaging Series

Using  the  hospital  computer,  Launch  Insight  Web  by  selecting  the  icon  on  the
desktop and sign in using your  PACS credentials.  Open the Patient  Explorer  by
selecting the icon shown below in the top left hand side of the screen.

The patient explorer window (shown above) will  open. Select the “patient search”
option in the top left hand corner and enter your patient’s first and last name in the
“surname / forename” boxes and press search. When you search a patient name, all
patients with that name will be displayed in a list below the search box. Use your
patient’s date of birth to check that you have selected the right patient. Be sure only
to open patient records of patients who have consented to be in our study as this
database contains confidential, personal, and anonymised medical data. 

When you have found the correct patients, scroll through the scan list (marked in a
green box) to select relevant files. As of now, we’re interested in all CT Head and
MR Head files for each patient. Once you have found a relevant file, drag it to the
“TABLET COGNITIVE” folder which will  be displayed in the menu containing the
“patient search” folder (marked in red). 

You will then be prompted to enter patient info (see below). Enter the patient’s study
ID underscore temp (e.g.  P5211_temp) in  both  the  forename and surname box.
Once you have dragged files into this folder,  the system will  automatically move
them into the ClearCanvas workspace.

Anonymising and deleting Dose Pages
You will now switch over to the other computer (the university computer) and

launch ClearCanvas by selecting the program’s desktop icon.

In ClearCanvas, select “My Studies”. Patient Data which you have downloaded to
the TABLET COGNITIVE file will appear in the window marked in blue. This can take
some time, so be patient.

When a relevant study appears, right hand click on it and select “view series details”.
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We will now delete the DOSE page. Note that not every scan (especially MR scans)
will have a dose page, but if there is one it is extremely important for us to delete it
before taking this data. The DOSE page contains each patient’s name and NHS info.
It is a breach of our ethics to take this data out of the hospital. The DOSE page will
generally be labelled “999” but it can be labelled other things as well. You can open
up each scan session to check whether it contains patient information.  Once you
have found the DOSE page, right click it and select “delete”.

Next,  we  will  need  to  anonymise  each  scan.  To  do  this right  click  on  each
examination, select “Anonymize” and fill in the following:

Patient ID: CNC ID (e.g., P5001)
Patient’s Name: CNC ID (e.g., P5001)
Date of Birth: This will auto change day and month, but keep original year.

Change this to today’s date to avoid future error…
Study Description: Leave this as original
Accession Number: Make this a random number, try to not reproduce the
same pattern (e.g., 78324923721)
Study Date: IMPORTANT, make sure you change this back to the original
Study Date. This can be found under the study date column in the viewer. You
can also check these two match once you select  okay on the Anonymize
Study GUI, as each will be in the clearcanvas viewer. 

Transferring Anonymised Files to a Hard-Drive
To find where the data on clearcanvas is located, you need to first right-click on a
series and select open. Then you can go to Tools, Utilities, Locate on Disk. This
should point you to the filestore.

You can now transfer the scans (which are back one directory in filestore) to an
encrypted  hard-drive.  The  total  amount  of  files  in  filestore  should  be  the  same
amount of exams on my studies in Clear Canvas. Please note, for CNC scans where
we generate a anonymized version, we will need to delete the originally pulled scan
before transferring (please see this process below in the following step).

If  you  are  moving  the  location  of  these  filestore  file  to  somewhere  else  on  the
computer, please copy paste them instead of dragging them. There is a chance that
dragging the files might cause an error with the link between the file locations and
the data in clearcanvas. 
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NOTE: after you transfer (or copy-paste) the files from the filestore, PLEASE
DO NOT delete them from filestore. 

Deleting files from OUH computer and Exit procedure
Deleting files on the university computer (ClearCanvas): 

From ClearCanvas, you should only ever remove files using the right click,
delete, or using the X button. 

On the Hospital computer (Insight):
Within Insight, you can remove files from your examination directory by using
right click, delete. Only do this after the data has been sent to ClearCanvas. 

Once you have finished, please ensure that you have logged off of both computers
and shut them down. Please also unplug the OUH computer’s ethernet cable from
the wall socket and put back the cable that was originally plugged in. 

Other potentially helpful notes:
1. If you accidently deleted a file from the filestore or move them out, you might need
to run the following from clearcanvas: Tools, Re-index FileStore. This will update all
of the files saved in clearcanvas to the file store. 
2. The computer on the left is currently a university computer (donated by CNC) and
will eventually need to be updated with Windows 10 by someone at on the University
side,  who  will  then  be  responsible  for  looking  after  this.  For  ClearCanvas,  the
computer  must  be  a  static  IP  and  at  the  moment,  the  university  computer  is
satisfying this criterion. It is possible to make the OUH computer (on the right) static,
but that will require everyone to log in using OUH credentials.  
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